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Learn how to write server side Java™ code in the form of a User Defined Routine
(UDR), running inside the Informix® Dynamic Server (IDS). Also, learn how to set up
your project using modern tools such as Eclipse.

Section 1. Before you start

Learn what to expect from this tutorial, and the technical environment.

Introduction

Although IDS is one of the best general purpose and online transaction processing
(OLTP) databases out there, you may need to extend its function set. IDS provides a
very open interface for doing so: UDRs. UDRs can be developed in Java, making
portability a non-issue, helping you benefit from your existing Java knowledge and
letting you reuse libraries and components already available in your applications.
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Objectives

In this tutorial, you first discover the fundamentals then directly jump to a real-life
example. You also call your Java UDR from an Informix 4GL application. You then
see how you can include this example into Eclipse, the famous development
environment. Finally, you study the deployment strategy to use your UDR in
production.

Prerequisites
It is assumed that you have development experience with IDS. No Java or Informix
4GL background is required.
System requirements
In this tutorial,you will use the following:
* IDS V10.0.TC4
* J2SE Development Kit (JDK) V5.0 (update 6)

» and Eclipse V3.2 RC7

This example uses Windows XP, but the examples are easily portable to Linux or
any other UNIX system.

Section 2. Fundamentals

IDS, like in many other areas, has been the innovator and technology leader in
embedding Java Virtual Machine (JVM) technology in a database server. This
powerful feature, called J/Foundation, has been part of IDS since Version 9 (then
called Informix-Universal Server) was released following the 1996 acquisition of
lllustra by the Informix Corporation.

A UDR is a routine that you create and register in the system catalog tables and
then invoke within an SQL statement. A UDR can be either a function (can accept
arguments and can return values) or a procedure (can accept arguments but does
not return values).
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Note:The test bed in this example is called scoobidoo. It is a Windows XP
Professional SP2 machine running IDS 10.0.TC4 as ol_scoobidoo. The Informix
user has the Informix password. The engine is installed on C:\Program
Files\IBM\Informix (%INFORMIXDIR% as this is on Windows). You will work in
C:\UDRProject.

In order to activate J/Foundation in IDS, certain onconfig parameters must be set
and a JVM must be available. On your system, the onconfig configuration file is
ONCONFIG.ol_scoobidoo, available in %INFORMIXDIR%\etc.

Onconfig parameters
The default system smart blob space (sbspace) is sbspacel. This is where your

database server stores your Java UDR Java archive (JAR) files and your smart
blobs, unless a specific dbspace was provided for them.

SBSPACENAME sbspacel

If you have not set up a smart blob space during the initial installation, you can do so
by using the onspaces command:

onspaces

-C
- S sbhspacel

-p C\|I FMXDATA\ ol _scoobi doo\ shspacel_dat . 000
-0 0

-s 10000

The appendix details the use of onspaces. The number of Java Virtual Processors
(JVPs) that the database server should start. It is commented by default.

VPCLASS j vp, nun¥l

The following is the installation directory for the database's Java Runtime
Environment (JRE). The default is $INFORMIXDIR/extend/krakatoaljre.

JVPJAVAHOME C:\ PROGRA~1\ | BM I nf or mi x\ ext end\ kr akat oa\jre

The following is the directory where the J/Foundation classes and JDBC classes are
installed. The default is SINFORMIXDIR/extend/krakatoa.

JVPHOVMVE C:\ PROGRA~1\ | BM I nf or m x\ ext end\ kr akat oa
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Warning: The Java UDRs JDBC driver is not the same as the JDBC driver found in
the client. The UDRs JDBC driver complies to JDBC V2.0, whereas the driver
coming with the client package is compliant to JDBC V3.0. Be careful about that
when deploying. The JDBC driver in the client package does not support the
Informix-direct protocol.

Java traces, output, and stack dumps are written to this file by the database server.
On this system, the default was ol_scoobidoo_jvp.log.

JVPLOGFI LE C:\ PROGRA~1\ | BM | nf or mi x\ ext end\ kr akat oa\j vp. | og

This is an optional parameter. When set, it points to the path of the JVP properties
file. On this system, the default was .jvpprops_ol_scoobidoo. Trace level settings,
trace verbosity settings, monitor port, and a few other properties are set in this file.

JVPPROPFI LE C:.\ PROGRA~1\ | BM | nf or mi x\ ext end\ kr akat oa\ . j vppr ops

This is the major JDK version supported by the database server. For IDS V10, the
valid values are 1.4, 1.3, and 1.2. Unless you have a specific reason to use an older
version, leave 1.4.

JDKVERSI ON 1.4

Note: IDS V10.00.TC3 and V10.00.TC4 for Windows come with the IBM JRE
Version 1.4.2.

The following is the path to the JVM libraries relative to JVPJAVAHOME, the default
value is fine.

JVPJAVALI B \ bi n\

The following is a list of the JVM libraries that the database server loads. Unless you
have very specific requirements, leave the default values.

JVPJAVAVM j si g; dbgmal | oc; hpi ; jvm java; net; zi p; j peg

This parameter sets the CLASSPATH for the J/Foundation JAR files (krakatoa.jar
and jdbc.jar) for the database server to use during startup. The default value is fine.

JVPCLASSPATH C: \ PROGRA~1\ | BM I nf or m x\ ext end\ kr akat oa\ kr akat oa. j ar;
C. \ PROGRA~1\ | BM | nf or mi x\ ext end\ kr akat oa\j dbc. j ar
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The following are the memory settings for the JVM:

JVPARGS - Xnms128m - Xnx128m

Very important: This parameter is not set for you and it may not even be in the
onconfig.std file, yet it is a critical parameter. This is where you set the options for
the JVM, including the amount of memory it can use.

The onconfig line shown above allocates 128 MB to the JVM. If you do not set this
parameter, you only get 16 MB by default.

You should also be aware of the JAR_TEMP_PATH environment variable. Set this if

you want temporary JAR files to be stored somewhere other than C:\tmp (Windows)
or /tmp (UNIX).

JAR TEMP_PATH

Very important: If this environment variable is not set, and the directory does not
exist, you get an error when you try to install your file(s).

You should restart the Informix engine (the Windows service) before you can use the
Java UDRs. To check that everything works fine, try the following:

onstat -g glo| grep jvp

You should get the following:

jvp 1 0. 00 0. 00 0. 00
3 6052 jvp 0.00 0.00 0.00

Note: Start the Informix engine from the command line on Windows. For more
information, refer to Restart the Informix engine from the command line.

Note: If you do not have a grep command on your Windows system, use more (or
getone):onstat -g glo | nore.

Section 3. Advantages

The following are some of the advantages of UDRs:
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Application speed and reduced bandwidth load

The primary reason to deploy application functionality in the form of a UDR should
be to keep this functionality where it belongs, for example, in the server. The
increasing use of the client or server and especially Web applications, bring with
them the need to minimize the network traffic between the client and the server. This
IS true no matter how fast the connection in between may be. The less traffic there
is, the faster the application runs. It also positively impacts the performance of other
applications that depend on the same pipe, because of the reduced load on the
bandwidth. Server disk 1/0O intensive applications are the perfect candidate.

Those of you who have developed or supported a thick client application that makes
heavy use of cursors over a Wide Area Network (WAN) connection, know how
important it is to have a high speed network bandwidth. And also how much network
traffic such an application creates. A UDR allows almost all of that to take place
inside the database server, without slowing down due to network bandwidth
capacity. It should be mentioned that we are not advocating Java UDRs as the best
way to write applications. They have a specific purpose, they are a good tool and
technology to use in certain applications. Mainly, where your application deployment
need is on the server side and also if it is somewhere between writing a stored
procedure and writing a client based or server based function or executable.

Ease of deployment

Server-side deployment is fast and much easier when compared to client-side
installation. Within a few minutes, and from a central location, new application
functionality can be added in the form of a JAR file.

Rich, standard full programming language

Instead of being limited to SQL or a proprietary stored procedure language, you can
take advantage of a modern object-oriented standard programming language for
server-side routines. The code is nearly 100 percent portable because it is written in
an industry standard programming language, Java, which works with most industry
leading databases and all industry leading operating system platforms.

Application layer flexibility

Thanks to the use of an industry standard programming language, if you decide to
run your code outside the server, you can do so with minimal work. This is not
possible to do with a proprietary stored procedure language.

Push the limits of Java UDRs in Informix Dynamic Server V10 Trademarks
© Copyright IBM Corporation 2006. All rights reserved. Page 6 of 48


http://www.ibm.com/developerworks/ibm/trademarks/
http://www.ibm.com/legal/copytrade.shtml

ibm.com/developerWorks developerWorks®

Function centralization

In environments where multiple applications, perhaps each written in a different
language, frequently have to perform a certain task in a common way (for example,
calculate the total cost of a certain manufacturing part), implementing this common
function as a UDR, can enable all these applications to use the same routine with an
SQL call.

Section 4. Hello world example

The best example of all is always the same: the indefatigable hello world from our
masters, Kernighan & Ritchie.

Now see how it applies to Java UDRs within IDS. You are going to create a simple
function that returns the traditional message. In order not to interfere with the rest of
the example, work in C:\ProjectUDR\hw.

The following is a step-by-step process to create a hello world Java UDR.

Step 1. Design and code your Java classes
Listing 1. The hello world UDR (HelloWorld.java)

public class HelloWrld {

public statlc String getHeIIoWJrId() {
return "Hello, world.

Step 2: Compile your code
Here are the simple commands to build the UDR.

Listing 2. Compiling the hello world example

del *.class
javac -source 1.4 -target 1.4 Hell owrld.java
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Note: If you get an error message: ' j avac' is not recogni zed as an

i nternal or external command, operable programor batch file,
make sure that your JDK bin directory is in the path (C:\Program
Files\Java\jdk1.5.0_05\bin on the example system). For more information, refer to
the Appendix.

Step 3: Build a JAR file

erase hw. jar
jar cvf hw jar Hellowrld.class

Note: For Advanced Java users, it is not necessary to include a manifest file in the
JAR file.

Step 4. Install your JAR file

Install the JAR file in the engine and create its corresponding SQL function (this
assumes that your database is logged -- you do not have to use BEGIN
WORK/COMMIT WORK if you do not want to). Run DB-Access and connect to the
stores_demo as a user having the EXTEND privilege (the Informix user has it).

Listing 3. SQL install script for hello world

BEG N WORK;
EXECUTE PROCEDURE sqlj.install _jar
("file:\C \UDRProject\hw hw jar",
"hw jar',
0);
CREATE FUNCTI ON get Hel | oWor | d()
RETURNS CHAR(50)
EXTERNAL NAME ' hw_j ar: Hel | oWor | d. get Hel | oWor | d*
LANGUAGE JAVA;
GRANT EXECUTE ON FUNCTI ON get Hel | owor i d() TO ALL;
COW T WORK;

Step 5: Run

Now you can run it.

EXECUTE FUNCTI ON get Hel | oWor | d() ;

Figure 1. DB-Access running your first UDR
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SQL: Hew BITUN Hodifw
Run the current S

ionk

Hello, world...

1 rowifs? retrieved.

Section 5. A real-life example

Ther UDR example, PriceChanger.java, is built for the superstores demo database
that comes with IDS. Given an effective date and a percentage, the UDR goes
through the orders in the database and changes the prices if they meet the date
criteria. This example demonstrates that it is possible (and practical) to build
object-oriented, server-based applications running inside the database server. The
applications can utilize multiple classes and practically all the features and
functionality of the Java language.

Building the UDR step-by-step, follow the same steps you did previously.

Step 1. Design

The main design goal was to have a reusable component, called
PriceChangerGeneric. It contains all the processing and business logic.
PriceChangerGeneric needs two things to do its job:

» A database connection (Connection)
* A logging system (Loglinterface)

In this implementation, PriceChangerGeneric gets a direct connection to IDS and the
logging system uses the UDR logging system. For more information, refer to the
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Troubleshoot through tracing and logging section. In other words, you have isolated
the business logic and it could work with an engine that does not have Java UDRs or
any other piece of software. It is reusable.

The added value resides in PriceChanger. It calls SuperStoresConnection to build
the connection to the engine, instantiates LogUDR to have a LogInterface compliant
logging system.

You are using four classes and an interface:

* PriceChanger.java: Sets-up the interface to the engine.

« PriceChangerGeneric.java: Does the processing.

» SuperStoresConnection.java: The connection class to the engine.
* Loglinterface.java: Defines a basic logging interface (or contract).

* LogUDR.java: Implements the Loglnterface so it can be used in various
places.

Listing 4. PriceChanger.java

package net.jgp. | ab. udr.pricechanger;

i mport java. sql.Connecti on;
i mport java. sql . SQLExcepti on;

/**

* Price Changer class
*

* The role of this class is to enable the "interface" between the
:/busi ness |l ogic and both the database engi ne and the | oggi ng system
pubLLc cl ass PriceChanger {

/: Dat abase connecti on

pr{vate stati ¢ Connecti on udr Conn;

/**

* This is the "entry point" of the UDR The SQ function that can be
called fromclient applications corresponds to this nethod.

@aram effectiveDate Effective date of change.
@ar am per cent Change Percent of change.
@eturn 0 when everything's ok, 1 if error.
@hrows Exception If something goes w ong.

E

*/
public static int changePriceByPercent(String effectiveDate,
i nt percent Change) throws Exception {

int resultCode = 0;

/1 Instantiates the | oggi ng mechani sm

Logl nterface |i = new LogUDR();

l'i.log("PriceChanger.changePriceByPercent nethod started with "
+ effectiveDate + " and " + percentChange + "% ");
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try {
/1 Connection to the database
udr Conn = Super St or esConnect i on. connect () ;
if (udrConn == null) {
li.log("Connection to the database failed.");
return resul t Code;

/1 Then we ask the driver to do the actual processing.
Pri ceChanger Generi c priceChanger Generic = null;

/1 W give the driver its required el enents, the connection to the
/| database and the | ogging system
pri ceChanger Generi ¢ = new PriceChanger Generic(udrConn, |i);

li.log(3,
"Pri ceChanger. changePri ceByPercent established connection.");

/1 W give the driver its business related parameters
pri ceChanger Ceneri c. set Par anet er s(ef fecti veDat e, percent Change);

/1 The job will now be done
resul t Code = priceChanger Generic.drivePri ceChanges();

/1 W are closing the connection
Super St or esConnect i on. cl ose();

}
catch (SQLException ex) {

ex. print StackTrace();
t hr ow ex;

// we return the result code
return resul t Code;

}
} /1 end class

Java does not provide the return of multiple values, your UDR does not support
multiple return values either.

Important: Do not forget to close your ResultSet and Statement objects. Otherwise,
you will run into problems and you may even cause IDS to crash.

Listing 5. PriceChangerGeneric.java

package net.jgp. | ab. udr. pricechanger;

i mport java. sql.Connecti on;
i mport | ava. sql . PreparedSt at ement ;
i mport java.sql.SQ.Excepti on;

/-k*
* Price Changer Ceneric cl ass.
*
* This class does the effective work. It applies the business rules to
* the data in the database. At this level, we do not care about the
* dat abase: we receive a connection and we do the processing. The
* connection can come froma UDR (direct connection) or from an
* indirect connection to database, making this piece of code highly
* reusabl e.
*/
public class PriceChangerGeneric {
/**
Push the limits of Java UDRs in Informix Dynamic Server V10 Trademarks
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* Dat abase connection

*/

private Connecti on dbConn;
/**

* Effective date

*/

private String effectiveDate;
/**

* Percent change
*/

private int percent Change;

| **

* Log

*/

private Loglnterface | og;

| **

:/Update stock unit price statenment

private PreparedStatenment updateStockUnitPriceStatenment;
[ **

* Update itens for price change statenent
*/

private PreparedStatenent updateltensForPriceChangeSt at enent ;

/**
* The constructor expects the two required paraneters.
*/
publ i ¢ PriceChanger Generi c(Connecti on databaseConnecti on,
Logl nterface | ogSystem {
t hi s. dbConn = dat abaseConnecti on;
this.log = | ogSystem

/**

* Sets the effective date and price change percentage of this object.
*

* @aram ef fectiveDate
* @ar am per cent Change
*/

public void setParaneters(String effectiveDate, int percentChange) ({
this.effectiveDate = effectiveDate;
t hi s. per cent Change per cent Change;

/**
* This is the main driver nethod for the price changes. It first

* updates stock.unit_price for all stock items. It then updates

* jtens.itemsubtotal in orders whose dates (orders.order_date) are
* on or after the price change effective date that have not yet been
* paid (orders.paid_date is null).

*
*

@eturn resultCode 0 if successful, 1 if error

*/

public int drivePriceChanges() throws SQLException {
int resultCode = 0;
String sql Statement = null;

try {
this.log.log(3, "Driving with drivePriceChanges nethod...");
this.log.log(3, "percentChange=" + this.percentChange);
this.log.log(3, "effectiveDate=" + this.effectiveDate);
/1 first, update the prices in the stock table
sql St at enent = "UPDATE stock "
Push the limits of Java UDRs in Informix Dynamic Server V10 Trademarks
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+ "SET unit_price = unit_price + ((un|t _price * ?) [/ 100)

+ "WHERE unit_price |I'S NOT NULL

thi s. updat eSt ockUni t Pri ceSt at ement = dbConn
. prepareSt at enent (sql St at enent) ;

thi s. updat eSt ockUni t PriceStatenment.setlnt(1, this.percentChange);

thi s. updat eSt ockUni t Pri ceSt at enent . execut eUpdat e() ;

[/l then, find the orders that neet the effective date criteria and

/1 update their itens

sql St at ement = "UPDATE itens"
+ SET item subtotal = itemsubtotal +"
+ " ((itemsubtotal * ?) / 100)" + " WHERE order _
+ " (SELECT order_num FROM or ders"
+ " WHERE paid_date |'S NULL AND order _date >= ?)";

t hi s. updat el t ensFor Pri ceChangeSt at enent = dbConn
. prepareSt at enent (sqgl St at enent) ;
this. updat el t emsFor Pri ceChangeSt at enent . set | nt (1,
t hi s. per cent Change) ;
t hi s. updat el t emsFor Pri ceChangeSt at ement . set Stri ng(2,
this.effectiveDate);

thi s. updat el t ensFor Pri ceChangeSt at enent . execut eUpdat e() ;

// Conmits the transaction
thi s. dbConn. commi t () ;

}

catch (SQLException ex)
thi s. dbConn. rol | back();
resul t Code = 1;
ex. printSt ackTr ace();

throw ex;
}
/1 d eaning
thi s. updat eSt ockUni t Pri ceSt at ement . cl ose();
t hi s. updat el t ensFor Pri ceChangeSt at enent . cl ose() ;

return result Code;

}

} /'l end class

Listing 6. SuperStoresConnection.java

package net.jgp. | ab. udr. pricechanger;

i mport java. sql. Connecti on;
i mport java.sql.DriverManager ;
i mport java. sql . SQLExcepti on;
| *x
:/ Dat abase connection cl ass
public abstract class Super StoresConnection {
[ **
:/ Dat abase connecti on
private static Connection udrConn = null;
[ **

* Perforns the actual connection to the database.
*

* @eturn Connection object.
=

public static Connection connect() throws SQ.Exception {
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if (udrConn !'= null) {
System err

.println("Connection is already open, use close() first.");
return null;

try {
/] Loads the driver
Cl ass. forNane("com i nform x.jdbc.|fxDriver");

/] Connect to the database. Note that the URL to connect to the
/1 database is not the sane as the usual one used by the JDBC
/1 driver, here we have a *direct connection* to the engine.
udr Conn = Dri ver Manager

. get Connection("jdbc:inform x-direct: superstores_denn");

/1 Set sonme paraneters
udr Conn. set Aut oConmi t (f al se);

}

catch (SQLException sql ex) ({
sql ex. print StackTrace();
t hrow sql ex;

}
catch (C assNot FoundException ex) {
Systemerr.println("d ass not found exception...");

return udr Conn;
} // end connect ()

/**
* Cl oses the connecti on.
*/
public static void close() {
if (udrConn !'= null) {
System err
.println("Connection is not open, use connect() first.");
return;
}
try {
udr Conn. cl ose();

}
catch (SQLException ex) {
ex. printStackTrace();

} }/ end cl ose()

} // end class

As you can see, the connection is done through Informix-direct, the direct connection
is an internal connection, so it does not open a new session to the database. It also
remains within the same transaction.

The source code for the log files is found in the Troubleshoot through tracing and
logging section.

Step 2: Compilation

Use the provided batch file, compile.bat. It contains a little more than Listing 2:
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» Packages
* Elements from the Informix libraries

As you use a package (net.jgp.lab.udr.pricechanger), it physically maps to the
net\jgp\lab\udr\pricechanger directory. Use an environment variable (workdir) to
make the compilation process easier.

You will se two libraries (JARs) coming from the Informix package: krakatoa.jar and
jdbc.jar, which are located in C:\Progra~1\IBM\Informix\extend\krakatoa, thus the
use of the INFORMIXKRAKATOADIR environment variable.

Listing 7. Compiling the PriceChanger example (compile.bat)

set wor kdi r=net\j gp\Il ab\ udr\ pri cechanger

set | NFORM XKRAKATQADI R=C: \ Pr ogr a~1\ | BM I nf or m x\ ext end\ kr akat oa

set CLASSPATH=%CLASSPATH% . ; %4 NFORM XKRAKATOADI R% kr akat oa. j ar ;
% NFORM XKRAKATQADI R% j dbc. j ar;

del %workdir% *.cl ass

javac -source 1.4 -target

javac -source 1.4 -target

javac -source 1.4 -target

javac -source 1.4 -target

%or kdi r % Pri ceChanger. j ava

%or kdi r % Pri ceChanger Ceneri c. j ava
%or kdi r % Super St or esConnecti on. j ava
%or kdi r % LogUDR. j ava

SRR
ENJNFNEN

Step 3: Build a JAR for deployment

Building the JAR file remains a very easy process.

erase pc.jar
jar cvf pc.jar

Step 4: Install
Using DB-Access, log in to the superstores_demo database as informix.

Listing 8. SQL install script for PriceChanger (install.sql)

BEG N WORK;

EXECUTE PROCEDURE sqlj.install _jar(
"file:\C \UDRProject\pc\pc.jar',
‘pc_jar',

O .

)
CREATE FUNCTI ON changePri ceByPer cent (

ef fectiveDat e CHAR(10),

per cent Change | NTECER)

RETURNS | NTEGER

EXTERNAL NAME

"pc_jar:net.jgp.lab.udr.pricechanger. Pri ceChanger. changePri ceByPercent'

LANGUAGE JAVA;
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GRANT EXECUTE ON FUNCTI ON changePri ceByPer cent (CHAR, | NTEGER) TO ALL;
COW T WORK;

You are likely to need to remove your UDR as well (to install a new one perhaps),
and here is how to do that.

Listing 9. SQL uninstall script for PriceChanger (uninstall.sql)

BEG N WORK;

DROP FUNCTI ON changePri ceByPer cent ;

EXECUTE PROCEDURE sqlj.renove_jar('pc_jar', 0);
COW T WORK;

Listing 10. SQL update script for PriceChanger (update.sql)

BEG N WORK;

EXECUTE PROCEDURE sql j . replace_jar(
"file:\C \UDRProject\pc\pc.jar',
‘pc_jar');

COW T WORK;

Step 5: Run

You are now ready to execute the UDR. The following paragraphs illustrate how to
run your new UDR from DB-Access and a 4GL application.

Call from DB-Access

The example UDR can be called from DB-Access as follows:

EXECUTE FUNCTI ON changePri ceByPer cent (' 2006- 05-01', 10);

Call from a 4GL application
Calling the UDR from 4GL is similar to calling it interactively.

Listing 11. Call to PriceChanger from 1-4GL

LET udr_statenment _string = "EXECUTE FUNCTI ON changePri ceByPercent (?, ?)"
PREPARE udr _st at enent
FROM udr _st at enent _string
EXECUTE udr _st at enmrent
USI NG ef f _date, chg_percent
I NTO udr _result_code
FREE udr _st at enent

Important tip for 4GL users: If you are calling your UDR from Informix-4GL, be
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sure to FREE the statement. Otherwise, the virtual memory segment will not clear
properly.

Section 6. Troubleshoot through tracing & logging

UDR tracing can generate messages written to the JVP log file specified by the
JVPLOGFILE onconfig parameter. com.informix.udr.UDRTraceable is the name of
the Java interface for tracing. UDR tracing uses “trace zones” -- this is a “logical”
concept where you can name multiple zones in one UDR or one zone for all your
UDRs. Within each zone, you can have six levels of detail, from zero (off) to five
(superfine, or the most detailed).

You can see this in the example code.

Listing 12. LogInterface.java

/**

* An interface defines a "contract" between the user and the

* inplenmentor. In this case, it neans that all inplenentations
of

* Loglnterface nust match all the functions |isted here.
However, the ) _ )
* inplementation is free to do whatever it wants: log via the

UDR

* ] ogging system |og using Log4J (a popul ar Java | oggi ng
systen), |og

* using web services on a renote host, send SNW events, etc.
*/

package net.jgp. | ab. udr. pricechanger;

public interface Loglnterface {

/**
* Logs a sinple nessage.
*
* @aram | ogMessage The nessage to | og.
*/

void |l og(String | ogMessage);

/**

* Logs a sinple nmessage associated to a | evel.
*

* @aram | ogLevel Level to |og.

* @aram | ogMessage The nessage to | og.
*/

void |l og(int |ogLevel, String | ogMessage);

/**

* Logs a sinple nessage associated to a level and a zone.
*

* @aram | ogZone Zone to redirect the | og nessage to.

* @aram | ogLevel Level to |og.
* @aram | ogMessage The nessage to | og.
*/
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void log(String | ogZone, int |oglLevel, String | ogMessage);

The interface is the contract given to all classes in need of logging. The real
implementation is found in Listing 13.

Listing 13. LogUDR.java

package net.jgp.| ab.

i mport com i nform X
i mport com i nform X
i nport com i nform x
i mport com i nform x

/**

. udr

udr .

pri cechanger;

. UDREnv;
. udr.
. udr.
. udr.

UDRLoOgQ;
UDRManager ;
UDRTr aceabl e;

* This is a basic |ogging systemthat inplenents the Loglnterface and
* relays all the logging work to the Inform x UDR | oggi ng cl asses.

*/

public class LogUDR i npl ements Loglnterface {

/**

* The default zone to |og to.

*/
private static fi

/**

* UDR Log
*/

nal

private UDRLog | og;

/**

* UDR Traceabl e
*/

String DEFAULT_LOGZONE = "sSTZ";

private UDRTraceabl e traceabl e;

/**

* The constructor establishes the link to the UDR API.
*

* @hrows Except
=

ion

public LogUDR() throws Exception {

UDRENnv env;

env = UDRManager . get UDREnv() ;

this.log = env.getLog();

this.traceabl e = env. get Traceabl e();

/1 used | og here because the super StoresConnection has not yet been

/] established
}

/**

* | npl ement ati on of basic |ogging.

*/

public void log(String | ogMessage) ({
this.log.log(l ogMessage);

/**
* | npl ementati on of basic logging with zone and | evel.
*/
public void log(String | ogZone, int |ogLevel, String | ogMessage) {
this.traceable.tracePrint(l ogZone, |ogLevel, |ogMessage);
}
Push the limits of Java UDRs in Informix Dynamic Server V10 Trademarks
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/**

* | npl ementati on of basic logging with level. Note that this nethod
*will simply foward the call to the log() function supporting the
* zone paraneter. The nethod will sinply use the default zone.

*/
public void log(int |ogLevel, String | ogMessage) ({

this.| og(DEFAULT _LOGZONE, | oglLevel, |ogMessage);

Section 7. Automate with Eclipse

It is agreed, there must be an easier way to develop a UDR by utilizing modern tools
like Eclipse. First, create a project within Eclipse, and then define some actions
within the Integrated Development Environment (IDE) using external tools.

Create the project within Eclipse
Create a new project

Start Eclipse and select your workspace if applicable. My workspace is available in
the C:\UDRProject\worspace directory. You should come quickly to the Welcome
screen. Close the Welcome screen. Go to File > New > Project.

Figure 2. Create a new Java project
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& New Project

Select a wizard

_reate a Java project

Wizards:

| kvpe Filker kext

= VS
= Eclipse Madeling Framewark.
(= EJB
= Graphical Madeling Framewark
(= J2EE
= Java

Tﬁ Jawa Project

% Java Praoject From Exisking Ant Buildfile
= PHP
= Plug-in Development
= YN

=

Zance|

Click Next. Enter your project name.

Advanced Note: | usually name my projects like my root packages, which in this
case will be net.jgp.lab.udr.pricechanger.

Configure Eclipse for Java 1.4

The JVM embedded in IDS is Version 1.4.2. This means that you need to provide it
with a Java 1.4 byte code (the result of the Java compilation). Although you are
using Java 5, you can produce Java 1.4 compliant byte code. Click Configure
JREs.... You get a Preferences panel, as shown in Figure 3.
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Figure 3. Preferences panel

loperWorks®

& preferences (Filiered) E @lgl
vpe fiker bext] w Installed JREs
= Java A, resmocee o el JRE dhefirations,
* Comgder By defant, the checked JRE &5 added to the buld path of newly created Mrva projects,
# Installed WEs Trist sl FEs:
e o o

B el 5.0 05 CoPrcgram Fles | avalrel 50 06 Standard W

¥ [ o || comn

Click Compiler. In the Compiler compliance level drop-down, choose 1.4. Your
preferences should look like Figure 4.

Figure 4. JDK compliance level

& Preferences (Fillered) E @lgl
tvpe Filter bext u  Compiler =
= Java
0k, Complancs
# Comger
5 Instoled MEs Compder comghance kevel: I -
|| tse def auk complance settings
Classfile Gonaration

[] tudd wariable atiribubes bo generabed cass files (used by the debugger)
[t e rruemiseer abbvibusbes b gersersted class Flas (used by the debugger)
[#] dd source file name to generated cass Fils (used by the debugger)
[]Prasarve unused (nevar read] kocal varisblss

[+#] 1riires Firvslty Bigcks (langer clas files, but impraved perfarmance)

[Restore pefaus | | apply

]

¥ | o || cown

Click Ok. Confirm by clicking Yes.

Figure 5. New Java project
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& New Java Project El

Create a Java project

Create a Java project in the workspace ar in an external lacation,

Projeck name: | net.jgp.lab.udr. pricechanger

_onkents

{E} Create new project in workspace

{:} Create project from exisking source

JRE

{(#) Use default JRE {Currently 'rel.5.0_ 06" Configure JREs, .,

{:} Use a project specific JRE:

Praject layout

(%) Use project Folder as rook For sources and class Files

(") Create separate source and output folders Confiqure default, .

Using a 1.5 JRE with compiler compliance level 1.4 is not recommended, Configure compliance. ..

L2 < Back ” Mext = ” Finish H Zancel

Click Finish.
Add the krakatoa libraries

Before you can add your code to the project, you need to add the Informix libraries
required for the development of your UDR.
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Warning: You need to use the engine’s library, as found in the krakatoa
subdirectory; not the one coming from the JDBC driver.

There are several ways of adding libraries to an Eclipse project. It is recommend that
you use one based on variables. This is easier when you share projects or work in a
team where installation directories may differ.

Right-click on your project in the Package Explorer, select the last element of the
contextual menu, Properties. Highlight Java Build Path, and select the Libraries
tab. You should see something similar to Figure 6.

Figure 6. Project libraries

& Properties for net.jgp.lab.udr. pricechanger

type filker besxt Java Build Path L=

Info - . ]

Beanlrfo Path & source | I Projects | B Libr aries | % Crder and Export

Builders JARs and dlass folders on the build path:

| @ =k JRE System Library [ire1.5.0_06] | Add JAR
% Java Code Style ' ® aryimal.ads —adiill

1 Java Compiler | Add External JaRs...
Javador Location

|
|
PHP Debug | addvariable... |
|
|

Profile Compliance and W
Project References [ Add Library...
Fefackaring History
Server

Task Tags
Yalidation

| add Class Folder...

A
[ e

(2) Ok I [ Canicel

Don't click on Add JARSs, select Add Variable.

Figure 7. Project libraries
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& New Variable Classpath Entry |:||E|r5__<|

Select variables ko add ta build path:

[“ECLIPSE_HOME - C:\Program Files\edlipse-3.2 |

El JRE_LIE - C:\Program Files)Javaljrel 5.0_0&ilibirt.jar

[ IRE_SRL - (empty)

% IRE_SRCROOT - (empty)

[ JUMIT _HOME - <:\Program Files\eclipse-3. 2\pluginsorg. junit_3.5.1

== JUMIT _SRC_HOME - CH\Pragram Files\eclipse-3. 2\ pluginstorg.eclipse. jdt

£

Configure Yariables. .

Zancel

Click Configure Variables > New. Enter a name for your variable
(INFORMIXKRAKATOADIR is used in this article), then click Folder and point to
%INFORMIDIR%\extend\krakatoa. Do not use an environment variable, use the full
path, like C:/Program Files/IBM/Informix/extend/krakatoa. It should look like Figure

8.
Figure 8. New variable entry
& New Variable Entry r5__(|
Mame: INFDRMIHKR#KQTGADIM
Path: | :/Program Files IEM InfFormix/extend krakatoa | File. .. |
| Folder... |
':'E':' Ik | | Zancel |

Double-click OK. In the New Variable Classpath Entry, select your new entry
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(INFORMIXKRAKATOADIR in this example), and click Extend. Select jdbc.jar and
krakatoa.jar in the list, and click OK (you can select both libraries by pressing the
Ctrl key). Click OK. You should see something similar to Figure 9.

Figure 9. Project properties are now set

& Properties for net.jgp.lab.udr. pricechanger

type Fiker et

Info

Beanlnfo Path
Buildsrs

Java Buikd Path
Java Code Skyle
Jawva Comgiler
Javador Location
PHP Debig

Profile Compliance and W
Praject References
Fefackaring History
Server

Task Tags
Yalidation

[ %

Java Build Path (4=

(8 Source | I Projects | B Libraries | 4 Order and Export
JARs and class folders on the build path:

# @ INFORMIKKRAKATOADIRjdbc.jar - C:\Progran | Add JRs...

* @ INFORMIEKRAKATOADIR fkrakatos. jar - C:Pre

|
& mh IRE System Library [jre1.5.0_06] | add External 1aRs... |
| add variable... |
| addibrary.. |
| add Class Folder... |
[ Remove ]
< >
(] 4 I[ Cancel

Click OK. You are now ready to code.

Add Code

Now that your project is ready, you can add the source code. In the Package
Explorer, highlight the project (shown in Figure 10).

Figure 10. Highlight project
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& Java - Eclipse SDK

File Edit Refactor Source Mavigate Search Project Run Windo
. - - - -0-Q-Q- EHEGE
Hierarchy = O

@ Bg T
1,1”5'- nek.jgp.lab.udr. draft [net.jgp.lab.udr. draft]

I:'E,I- net.jgp.lab.ude b [met, jgp. lab.udr . Fe]
I:'E,I- net.jap.lab.udr. pricechanger [net.jgp.lab.udr. pricechanger]

i Package Explarer X

Go to File > New > Class. The package used here is net.jgp.lab.udr.pricechanger.
The class is the same as before: PriceChange. Before clicking Finish, check that it
looks like Figure 11.

Figure 11. Create the PriceChange class
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& New Java Class

Java Class

Create a new Java class,

Source folder: | net,jgp.lab.udr. pricechanger

Package: | net,jgp.lab.udr. pricechanger

[ |Enclosing type: |

Marne: | PriceChange
Modifiers: (%) public () default
[ |abstract [ ]final

Superclass; | java.lang, Ohject

Interfaces:

Which method stubs would wou like to creater
[ ] public static waid mainString[] args)
[ | Caonstructors From superclass
Inhetited abstract methods
Do ol wank ko add comments as configured in the properties of the current project?

|:| Generate cormments

Firish ] [ Cancel

You can repeat the operation for the two other classes; PriceChangerGeneric and
SuperStoresConnection. You can then copy (or type) the source from the
PriceChanger.java, PriceChangerGeneric.java, and SuperStoresConnection.java
files.
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Define actions
Package the files
The first action you need to define is how to package your class files in a JAR.
Eclipse provides a convenient wizard to build the archive. Right-click on the project’s
name, and click Export. Select JAR file in the Java folder, as shown in Figure 12.
Figure 12. Export

& Export

Select

Export resources inko a JAR file on the local file syskem,

Select an export destination:

bvpe Filker text

== Java

2 davadoc

Zancel

You need to specify a few parameters:

* What: Leave the default (you can tune that later if you wish). Be sure to
have Export generated class files and resources checked, and leave
all the other check boxes unchecked.

* Where: The project directory has been selected, naming it pc.jar. As a
result, the JAR file is saved relatively to the workspace directory in
net.jgp.lab.udr.pricechanger/pc.jar.

Before clicking Next, check that it looks like Figure 13.

Figure 13. JAR export step 1
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&= JAR Export

JAR File Specification
(1) The export destination wil be relative to your workspace.

'1
Select the resources bo expork:
B[ ]52 net.jgp.lab.udr.draft |%] .classpath
. J
- []l=r ret.jgp.lab.udr. b %] . project

[ :ljl-l' rest. jgp.lab.udr . pricechanger

Export generated class files and resources
[ClExport all cutput Folders For checked projects
[C]Export java source files and resources

[ Expoat refactarings For checked projects.

Select the export destination:

JAR file: | net. jop.Jab. udr. pricechangerfpc. jar v

Options:
Compress the contents of the JAR Fils
[] Add directory entries
] orvervaribe existing files without warning

@ < [ Mext = ” Finish ” Cancel ]

Be sure to save the description in your project, as displayed in Figure 14. The
Description file has a jardesc extension. The description is saved in
/net.jgp.lab.udr.pricechanger/pc.jardesc. It allows you to reuse it in the future.

Figure 14. JAR export step 2
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JAR Packaging Options
Define the options For the JAR export,

Select options for handing problems:
Export class files with compile errars

Expork class files with compile warnings

Sawe the description of this JAR in the workspace

Description file: | Inet . jap.lab.udr . pricechanger fpc.jardesc

@ | <Back || mex> | Finish

H Cancel ]

Click Finish. As illustrated in Figure 15, you can see pc.jardesc and pc.jar in the

Project Explorer.

Figure 15. Export result

Hietarchy - =

: Package Explorer X

:;ﬁl- net.jgp.lab.udr. draft [net.jgp.lab.udr, draft]
& I[Eﬁ' net, jgp lab.udr, hl.-'-.l [met.jgp.lab. |_||:Ir Fud ]

. E]ﬂ nel:.]gp.Iab.udr.prlcechanger

B JRE Svystem Library [jrel.5.0_06]

E‘ jdbc.jar - INFORMIXKRAKATOADIR - CiiProgram FilesiIEM

E‘ krakatoa,jar - INFORMISKRAKATOADIR - CiiProgram Files
55 po.jar 46 71106 3:54 PM jgp

-ﬂ pc.jardesc 46 7106 3:54 PM jgp
Refresh the package
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Now, every time you have modified your source files and saved them (Eclipse
automatically compiles them), you can right-click on pc.jardesc and select Create
JAR. JAR is built automatically. Eclipse does prompt you to replace the existing JAR
file (as shown in Figure 16).

Figure 16. JAR replacement

& Confirm Replace PX|
The File
. 'CiDocumentst JeanGeorges\Researchiscoobidoo-workspace-3. 2inet. jap.lab.

udr. pricechangeripc.jar’ already exists,
Do wou wank ko overwribe it?

Install the package in the engine

Now you need to install pc.jar in the engine. Simply ask Eclipse to run DB-Access
with the install.sql script you used earlier.

Integrate your SQL scripts in Eclipse. To organize things a little, first create an sql
directory under the root project. Right-click on the project
(net.jgp.lab.udr.pricechanger), and select New > Folder. In the New Folder dialog
box, enter sql, and click Finish (as shown in Figure 17).

Figure 17. New SQL folder

Push the limits of Java UDRs in Informix Dynamic Server V10 Trademarks
© Copyright IBM Corporation 2006. All rights reserved. Page 31 of 48


http://www.ibm.com/developerworks/ibm/trademarks/
http://www.ibm.com/legal/copytrade.shtml

developerWorks® ibm.com/developerWorks

& New Folder

Folder

Zreate a new folder resource,

Enter or select the parent folder:

net.jgp.lab.udr, pricechanger

=

I:'E,I- nek.jgp.lab.udr. draft [net.jgp.lab.udr. draft]
I:ﬁ nekt.jap.lab.udr.bw [net, jgp.lab,udr Fea]
'[:'g"]! nek.jgp.lab.udr. pricechanger [net. jgp.lab.udr. pricechanger]

Folder name: | sql

| fdvanced = |

Right-click on the sql directory, and select New > Other. To ease navigation in the
New dialog box, you can type sqgl in the filter area. Select the SQL File under SQL
Development, and click Next.

Figure 18. New SQL file
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Select a wizard
i_reate a 3L File

Wizards:

=gl

== Data
EI 0L Scrapbook Page

== S5L Development
SL File

Mext = Finish iZancel

Check that the sql folder is highlighted. Type install.sql as the file name, and click
Finish.

Figure 19. New install.sql
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& New SQL File

Create SOL Fle

Enter or select the parent folder:

net.jgp.lab.udr. pricechangersgl

I:'E,I- nek.jgp.lab.udr. draft [net.jgp.lab.udr. draft]
I:ﬁ nekt.jap.lab.udr. b [net, jgp.lab,udr Fe]

= '[q";! nek.jgp.lab.udr.pricechanger [net. jgp.lab.udr. pricechanger]
= met
=3 sql

Filz name: | install.sql|

| fdvanced == |

In the editor, type the SQL install script (as shown in Listing 14).

Listing 14. SQL install script

CONNECT TO ' superstores_denmp' USER 'inform x' USING 'informx';

BEGA N WORK;
EXECUTE PROCEDURE sqlj.install _jar(
"file:\C \ UDRProj ect\workspace\net.jgp.|ab.udr.pricechanger\pc.jar',
‘pc_jar',
0);
CREATE FUNCTI ON changePri ceByPer cent (
effectiveDate CHAR(10),
per cent Change | NTECER)
RETURNS | NTEGER
EXTERNAL NAME
"pc_jar:net.jgp.lab.udr.pricechanger. Pri ceChanger. changePri ceByPercent'
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LANGUAGE JAVA;
GRANT EXECUTE ON FUNCTI ON changePri ceByPer cent (CHAR, | NTEGER) TO ALL;
COM T WORK;

Note that the install script is very similar to the one created previously. As you are
going to run it without being previously connected to the database, you simply need
to add a connect statement:

CONNECT TO ' superstores_denmp' USER 'informi x' USING'informx';

The path is also different as you are using the path in the workspace.

Click Run > External Tools > Select Program. You should see something similar
to Figure 20.

Figure 20. External tools management dialog box

® External Tools

Create, manage, and run configurations Q
Run & program "I'::LE
= i Configure launch settings From this dislog:
|type lor boxt. | ¥ = Press the Mew” button bo create a configuration of the selected bype,
L: = =
i% |5 - Press the 'Dupkcate” Button to copy the selected configuration,

B - Press the Delete’ button to remove the selected configurstion,
" - Press the Fiker' button to configure filtering options.

- Edit or view an existing configuration by sebacting i,

Configure launch perspective sektings from the Perspecties preference page.

@

As indicated, click New.

Table 1. Set up the Install UDR external tool

Tab Field Comment Default Value
Name Name of the tool. Install UDR
Main Location Location of C:\Program
DB-Access. Files\IBM\Informix\bin\dbaccess.exe
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Main Arguments Arguments to -
DB-Access. Note  ${project_loc}/sql/install.sql
that there is a
space between the
dash and the

dollar sign.

Environment Variable Value for C:\PROGRA~1\IBM\Informix
INFORMIXDIR.

Environment Variable Value for ol_scoobidoo

INFORMIXSERVER.

To add an environment variable, click on the Environment tab, then click New, and
type the name and then the value. Click OK. Do it for INFORMIXDIR and
INFORMIXSERVER. You should see something similar to Figures 21 and 22.

Figure 21. External tools configuration: Main tab

Mame: | Install UDR

mﬁh Refresh | 8 Environment | £ Comman

Locakion:

i \Program Files\IBM\ Informixbintdbaccess. exe

|Eru:|wse Workspace. .. | |Ernwsg File Swskem. .. | | Yariables. ..

Warking Directory:

|Eru:|wse Workspace... | |Eru:|wse File Swskem. .. | | Yariables. ..

arguments:

- ${project_lockH sqglfinstall, =gl

Mote: Enclose an argument containing spaces using double-guotes ().
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Figure 22. External tools configuration: Environment tab

Mame: | Install UDR

(=] Main | 5 Refresh m:. Camman

Environment variables ko sek:

Yariable Yalue
@ INFORMIXDIR CAPROGRA~1LIEMITN, ..
® INFORMIXSERVER ol scoobidoo s

{E} Append environment to native environment

() Replace native environment with specified environment

The actions you have defined are dependent on the current project. You have two
projects, net.jgp.lab.udr.pricechanger and net.jgp.lab.udr.hw. If your current project
IS net.jgp.lab.udr.hw, then, when you run the Install UDR action, you will use
install.sgl from net.jgp.lab.udr.hw, which will install hw.jar and the getHelloWorld
function.

To run it, click Run.

Once you have run it, it stays in the list of recent run configurations. To run it later,

click Run > External Tools, if it is in the list of recent runs, it will be available there.
Otherwise, click External Tools.... Alternatively, you can run it from the toolbar, as
displayed in Figure 23.

Figure 23. Run external tools from the toolbar
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Search  Proge Fun  Window  Help

¥.. 2 Install UDR.
3 Uninskall LDR

udr, draf
4, 4 Update LDR ECT

J8] Run As r
ATOoaDI

apIR -
Ir e ]

4, External Taals. ..

Drganize Favorites., ..
r

Update, check, and uninstall the package

You can now define the actions for checking, uninstalling, and updating the UDR.
You can either duplicate the Install UDR entry or reproduce and process it for each
external tool. Duplicating is the recommended method.

Click Run > External Tools > External Tools.... In the left column, you have Install
UDR (under Program), right-click on it and select Duplicate, as shown in Figure 24.

Figure 24. Duplicate an external tool

{:‘ = — |
MY SR IANE Marme: | Inst
kvpe filker bexk p—
£ ant Build :
Locakion:
= % Program —
@, Check UDR  CriProgr

=] [

¥ Delete

Change the name to Uninstall UDR. In the arguments field, simply change
install.sgl with uninstall.sql. Click Apply.

You can reproduce the operation for Check UDR with check.sqgl and Update UDR
with update.sql. Here are the required SQL scripts for the various operations:
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Listing 15. SQL uninstall script

CONNECT TO ' superstores_demp' USER 'inform x' USING 'informx';
BEG N WORK;
DROP FUNCTI ON changePri ceByPer cent ;

EXECUTE PROCEDURE sqlj.renove_jar (' pc_jar', 0);
COW T WORK;

Listing 16. SQL check / execute script

CONNECT TO ' superstores_denmp' USER 'inform x' USING 'informx';
EXECUTE FUNCTI ON changePri ceByPercent (' 2005- 05-01', 10);

Listing 17. SQL update script

CONNECT TO ' superstores_denmo' USER 'inform x' USING 'informx';

BEG N WORK;

EXECUTE PROCEDURE sql j . repl ace_j ar(
"file:\C \UDRProject\workspace\net.jgp.lab.udr.pricechanger\pc.jar',
‘pc_jar');

COMWM T WORK;

Section 8. Conclusion

Java UDRs are a good option to consider when you have to create server-based,
database-intensive applications.

Reduced network traffic and the use of a portable and fully object-oriented language
are some of the advantages of Java UDRs.

Setting up J/Foundation in IDS requires the availability of a JVM and the
configuration of several onconfig parameters.

It is possible to create simple, single class UDRs as well as more complicated ones,
consisting of multiple classes and an object-oriented application.

J/Foundation provides zone- and level-based tracing capabilities useful for
debugging during development and troubleshooting during production.

You need to be careful and meticulous about closing and freeing your statements
and result sets in Java UDRs in order to avoid memory problems.
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Finally and most important, by the time you’ve run all the examples, you'll notice that
your baseball glove, which used to cost $30, is now well over $60. If pricing could be
that easy.

Section 9. Appendix

Creating a Smart Blob Space (sbspace)
You have been advised do the following steps under the informix user.

When running:

onspaces -c -S sbspacel -p
C:\ | FMXDATA\ ol _scoobi doo\ shspacel_dat. 000
-0 0 -s 10000

The result should be:

Verifying physical disk space, please wait
Space successful |y added.

** WARNING ** A |level 0 archive of Root DBSpace will need to
be done.

If you get:

The file C \IFMXDATA\ ol _scoobi doo\ shspacel _dat. 000 does not
exi st.

Create the file first, by calling:

copy con C:\ | FMXDATA\ ol _scoobi doo\ shspacel_dat. 000

Press Ctrl+Z (or F6) then Enter to exit. The file is created and you can call the
onspaces utility again.

Install the Super Stores database
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You are advised do the following steps under the informix user.

This example relies on the Super Store database, which is not installed by default on
the system.

First you need to create an empty file that will contain the Smart Blob Space.

copy con C:\ | FMXDATA\ ol _scoobi doo\s9 sbspc_dat. 000

Press Ctrl+Z (or F6) then Enter to exit. You then need to run onspaces to create the
Smart Blob Space.

onspaces -c -S s9 sbspc -g 2 -p C\|FMXDATA\ ol _scoobi doo\ s9_shspc_dat . 000
-0 0 -s 2000

Finally, you can install it:

dbaccessdenpo_ud -I og—dbspace dbs_scoobi doo superstores_denp

Restart the Informix engine from the command line.

It is sometimes easier to do things through the command line rather than through
clicking. Here is a way to restart your IDS instance without using the mouse.

To stop the engine, type:

net stop "Informx IDS - ol _scoobi doo"

You should get:

The Inform x IDS - ol _scoobi doo service is stopping....
The Inform x IDS - ol _scoobi doo service was stopped successfully.

To start the engine, type:

net start "Informx IDS - ol _scoobi doo"

You should get:
The Inform x IDS - ol _scoobi doo service is starting.
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The Inform x IDS - ol _scoobi doo service was started successfully.

Listing the Virtual Processors

To be sure that your JVP is running, you can use the onstat command.

onstat -g glo

This is a typical result when the JVP is not running.

I BM I nform x Dynam c Server Version 10.00. TC4
-- On-Line -- Up 1 days 04:57:56 -- 21568 Kbytes

Ml gl obal i nfo:

sessions threads vps | ngspi ns
0 14 8 11
sched calls thread switches yield 0 yield n yield forever

total: 6343727 650771 5692983 208988 167929
per sec: O 0 0 0 0
Vi rtual processor sunmary:

cl ass vps usercpu syscpu t ot al

cpu 1 2.92 1.00 3.92

al o 1 0. 00 0. 00 0. 00

lio 1 0. 00 0. 00 0. 00

pi o 1 0. 00 0. 00 0. 00

adm 1 0. 25 0. 20 0. 45

soc 2 0. 00 0. 00 0. 00

nec 1 0. 00 0. 07 0. 07

t ot al 8 3.17 1.27 4. 43
I ndi vi dual virtual processors:

vp pi d cl ass usercpu syscpu t ot al

1 2472 cpu 2.92 1.00 3.92

2 3576 adm 0. 25 0. 20 0. 45

3 3580 lio 0. 00 0. 00 0. 00

4 3680 pi o 0. 00 0. 00 0. 00

5 3716 aio 0. 00 0. 00 0. 00

6 3720 nsc 0. 00 0. 07 0. 07

7 3724 soc 0. 00 0. 00 0. 00

8 3728 soc 0. 00 0. 00 0. 00

t ot 3.17 1.27 4. 43
This is a typical result when the JVP is running.
I BM I nform x Dynam ¢ Server Version 10.00. TC4
-- On-Line -- Up 00:01:27 -- 21568 Kbytes
Ml gl obal i nfo:
sessions threads vps | ngspi ns
0 14 9 0
sched cal |l s thread switches yield O vyield n vyield forever

total: 4829332 210947 4618410 129 105396
per sec: O 0 0 0 0
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Vi rtual processor sunmary:

cl ass vps usercpu syscpu tota

cpu 1 2.18 0.72 2.90

al o 1 0. 00 0. 00 0. 00

lio 1 0. 00 0. 00 0. 00

pi o 1 0. 00 0. 00 0. 00

adm 1 0. 00 0. 00 0. 00

soc 2 0. 00 0. 00 0. 00

nmec 1 0. 00 0. 00 0. 00

jvp 1 0. 00 0. 00 0. 00

t ot al 9 2.18 0.72 2.90

I ndi vi dual virtual processors

vp pi d cl ass usercpu syscpu tota

1 2888 cpu 2.18 0.72 2.90

2 2260 adm 0. 00 0. 00 0. 00

3 6052 jvp 0. 00 0. 00 0. 00

4 3784 lio 0. 00 0. 00 0. 00

5 2316 pi o 0. 00 0. 00 0. 00

6 5452 aio 0. 00 0. 00 0. 00

7 4876 nsc 0. 00 0. 00 0. 00

8 2928 soc 0. 00 0. 00 0. 00

9 3644 soc 0. 00 0. 00 0. 00
t ot 2.18 0.72 2.90

Add your JDK in the path

If you want to use the JDK on the command line, you should ensure that javac (the
Java compiler) is in your system path.

To check that it is available, start a command prompt and type javac. If you get the
following error message, continue reading.

"javac' is not recognized as an internal or external conmand,
oper abl e program or batch file.

Locate javac on your system. Typically it is in C:\Program Files\Java\jdk1.5.0_05\bin.
The minor version might defer on your system.

Click Start > Control Panel. Double-click on the System icon. Click on the
Advanced tab, and then click Environment Variables. In the system variables
block, find and select the Path entry. Click Edit.

Before typing anything, ensure that your cursor is at the end of the field. Press either
the right arrow key or the End key on your keyboard.

Type:

; C\Program Fi | es\ Java\j dk1.5.0_05\bin
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Do not forget the semicolon.

Click OK three times.

To check that it works, open a new command prompt and type javac, you should get
its usage.

Troubleshooting — Error #25785 (Informix error)

If you get:

25785: Cannot create external routine (gethelloworld) w thout the EXTEND rol e.

It means that you cannot create an external function or a procedure without the
privileges of the EXTEND role. You can either grant the role to the user or log in as
the Informix user. DB-Access lets you connect as a specific user: Connection,
Connect, Select your database server (here ol_scoobidoo), enter informix as the
username and then your password, and you can select the database.

Troubleshooting — Error #46002 (SQL State)

If you get:

(46002) - Attenpt to renmbve or alter path for non-existing jar:
(superstores_deno.inform x. hw jar).

Symptom: You are probably trying to update a JAR, which does not exist (like
launching the update script before the install script or just after the uninstall script).

Solution: Install the JAR first.

If you get:

(46002) - Attenpt to install an existing jar: (superstores_deno.inform x.pc_jar).

Symptom: You are probably running the install script but the JAR is already
installed.

Solution: Uninstall the JAR first or use the update script.

Troubleshooting — Error #46003 (SQL State)
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If you get:

(46003) - Invalid jar renoval. Al dependent UDRs not dropped.

You will have a hard time finding where the error is documented. It is a SQL State
error: “46003 Java DDL - Invalid class deletion”.

| originally made a typo when | installed the Hello World function and called it
“getHellowWorld” (notice the two ‘w’s). The function was installed OK (with the typo),
was running OK (with the typo) but uninstallation did not work as | was dropping the
function without the typo, and IDS did not want to remove the JAR file, and thus the
error #46003.

We used AGS’ ServerStudio and it listed all the functions available to me and we
discovered the wrongly-spelled function in the database.

Troubleshooting — Function not found

Another common problem is that the function is not found by the engine, simply

because the user does not have the rights to run it. Think about granting the right to
your users.

GRANT EXECUTE ON FUNCTI ON get Hel | oWorl d() TO ALL;

Problems when installing the source code

You may encounter some problem when installing the source code on your system,
as illustrated in Figure 25.

Figure 25. Problem during integration of the project
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The error Unbound cl asspat h vari abl e:

" | NFORM XKRAKATQADI R/ jdbc.jar' in project

net.j gp. ! ab. udr. pri cechanger, simply means that your
INFORMIXKRAKATOADIR variable is not defined within your workspace. To solve
the problem, refer to an earlier section of the tutorial where the
INFORMIXKRAKATOADIR variable was set.

Push the limits of Java UDRs in Informix Dynamic Server V10

© Copyright IBM Corporation 2006. All rights reserved.

Trademarks
Page 46 of 48


http://www.ibm.com/developerworks/ibm/trademarks/
http://www.ibm.com/legal/copytrade.shtml

ibm.com/developerWorks developerWorks®

Resources

Learn

» "Getting Started with IBM Informix J/Foundation on Linux" (developerWorks,
September 2002): Find step-by-step directions for configuring IBM IDS
J/Foundation for a 9.3x server on the Linux platform.

« DB2 Information Center: Find a list of valid SQLSTATE error codes.

» J/Foundation Developer's Guide, Version 10.0. G251-2291-00: Discover more
information about how to write UDRs in Java for IDS with J/Foundation.e.

* IBM Informix Dynamic Server Administrator's Guide, Version 10.0.
G251-2267-02: Use this user guide and reference manual to find features of
IDS.

* |IBM Informix Dynamic Server Administrator’'s Reference, Version 10.0.
G251-2268-01: Find reference material for IDS.

» IBM Informix DB-Access User's Guide, Version 10.0. G251-2277-00: Discover
how to use the DB-Access utility to access, modify, and retrieve data from IBM
Informix databases.

* IBM Informix Guide to SQL: Syntax, Version 10.0. G251-2284-02. Find detailed
descriptions of the syntax for all IBM Informix SQL and SPL statements.

» Visit the developerWorks Informix Zone to read articles and tutorials and
connect to other resources to expand your Informix skills.

* Learn more about Informix at the IBM Informix Dynamic Server v10.00
Information Center.

» Browse the technology bookstore for books on these and other technical topics.
Get products and technologies

» Download a free trial version of IDS.
Discuss

» Participate in the discussion forum for this content.

* The IIUG forums: Check them out to get more information and discuss this
article within the Informix developer community.
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